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INTRODUCTION

Welcome to Practical Digital Portraits, the latest e-book from
Duncan Evans. In this e-book are 10 chapters, varying in
complexity and style, covering many aspects of shooting
portraits. It starts with a guide to basic composition and the
kind of mistakes that can easily be made, whether they are the
fault of the photographer or a characteristic of the focal length
of lens being used. If you have never been in a studio then that
chapter will be invaluable as it explains how to use studio lights
with your DSLR. Then come the standard photo shoot tutorials
covering fashion styles and glossy portraits. From there it's a
trip into the past to see the classic styles of Bailey, the golden
age of Hollywood portraiture and the painted drama of James
Wedge and his Victorian dancing girls. To finish there’s a look
at period-themed shoots by organising a shoot at Whitby Abbey
with a Victorian-attired model, going on location for a massive
war weekend re-enactment, and rounding things off with some

post-apocalyptic shots from the near future.

Who is this book aimed at? Typically, a DSLR owner who knows
how to change a lens and turn the camera on, but wants to get
more out of the custom aperture, shutter speed, 1ISO and

metering settings, wants to learn a little more about lens effects



and who doesn’t have experience of carrying portrait shoots on
location or the studio. If you've never photographed a model
before, there are some helpful hints. Also, if you have a fully
featured compact camera then there’s plenty of advice here as a
lot of the book deals with location based photography. However
there are studio, or home studio, sections where being able to
connect your camera to studio flash lighting would be an
advantage. It isn't essential to have your own studio lighting
though. You can either hire the lights in a studio or simply
replicate some of the lighting ideas in other ways. In all aspects,
this is a practical book, explaining how to get things done, and

ways to make shots better.

Duncan Evans LRPS

www.duncanevans.co.uk



CHAPTER 1. BACK TO BASICS

Your guide to getting started with lenses and composition

The single, biggest mistake beginners to portrait photography
make is in regards to their choice of lens. When you first start
out, all it appears is that lenses simply make things appear
closer, and that's it. Except that they don’t and also, the longer
the lens, the more limited the aperture selection, particularly at
the wide open end — unless you spend thousands of pounds.
This chapter then, is about lens distortion, composition and

depth of field in portraits.

DISTORTION

The shorter the focal length of the lens, the wider the field of
view and the more curved the glass is on the front of the lens.
This means that when standing close to the subject, all the
detail that is further away from the central point will be
shortened and diminished as the light from the lens is bent into
the camera. Now, it's often the case that there isn’t much room
to take a photo and that consequently, you have to use a wide
angle lens — anything under somm can be considered wide — in
order to get everything in. Firstly, in these circumstances, ask

yourself, do you really need to see the whole of the person, or



will a head and shoulders shot do? If you really do want an
entire body shot, then you must be aware of the effect of

foreshortening.

How to get around it without moving back? Well, strictly
speaking, there isn’t any way around the effect, but you can
minimise it to a degree. Normally, the camera is at head height
and you are focussing on the subject’s face, so it's the same
height. This will lead to the torso and legs becoming much
shorter and the head longer. A quick fix is to drop down and
aim the camera at the chest area, so that this is the central
point and the legs and head are roughly balanced in terms of

their size.

Another alternative is to actually use the effect to play around
with the image. Get up on a chair and focus down at the
subject, and they will appear to be in a pit looking up. Have
the subject hold out a hand towards the camera and it will
appear to be the same size as their head. If they are sitting
down on the floor, point the legs towards the camera and they

will appear longer and will not look unnatural.

The actual solution to lens distortion like this is to use a longer
focal length lens and stand further back. While this isn’t always
practical because of space considerations, it can also limit the

lowest f-stop number available, which dictates the amount of



depth of field in the picture. Many top pro’s swear by using a
200mm lens to shoot portraits with, however you would need

an awful lot of room to use a lens that long. The other
advantage of a longer lens is that it offers a very narrow field of
view, so that once the subject is in it, nothing else usually is

there to distract the viewer.






In this shot, at head height, with a wide-angle lens, the legs

appear shorter, the head and torso longer.



By moving the lens downwards and pointing at the middle of
the subject, the distortion effect is lessened with the head and

shoulders appearing a more natural size compared to the
previous photo.









On this shot the camera is well above the subject — in fact |
was stood on a chair. The distortion effect is maximised for
creative effect, elongating the head and shortening the legs

dramatically.



More creative effects can be used by moving parts of the body
closer to the lens. The model sticks her hand towards the

camera and consequently it appears to be larger than her head.



i
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In this shot the legs are extended towards the camera, making
them longer, but this effect is actually quite pleasing for fashion,

portrait and glamour shots.



HEAD DISTORTION

The next two shots dramatically show what happens even with
head and shoulder shots, when you use a wide angle lens for
portraits. The composition for both is virtually identical. In the
first shot, the wide angle lens is used and distortion makes the
head appear elongated and the forehead bulges. In the second
shot, just by standing back 3 metres and zooming in, thus
extending the focal length, the distortion is completely removed.
The composition is the same, not much more room was

required, yet the picture looks far more natural.



Using a wide angle lens close up leads to distortion like this

where the forehead bulges



o

Exactly the same composition, but by standing further back and
using a longer focal length — literally zooming in — the head

distortion is removed and the picture looks natural.



COMPOSITION

You could write a whole book about composition, so we'll
concentrate on the basics. Composition is the art of putting a
picture together and using the space within. You will often hear
the following as a golden rule: “Never place the subject in the
middle of the photo.”

Obviously no-one told David Bailey that because his star
portraits from the 1960s broke exactly that rule. In fact, you can
learn a lot by studying Bailey's early work because it
revolutionised portraiture to the degree that the stylistic

approaches he created then are still popular today.

What that rule is actually trying to say is use the space
sympathetically. The reason Bailey’s centrally placed shots work
is because while the subject was stood facing the camera, the
cropping was right in close to maximise the facial features and
the personality, minimise the space to the sides, and equally
important, the lighting was from one side, so that the shadows

on the face were angled.

What you should not do is place the subject in the middle of a
wide angle scene because then you lose the impact and the

large space on either side of the subject is a dead area.



This picture is wrong compositionally. The subject is standing
slightly right of centre, but is looking off to the right. The
viewers' attention is lead out of the picture, rather than into it,

with dead space all down the left



The golden rule of composition is this: “Compose the photo to
lead the viewer's eye through it.” What this actually means is
that there should be no dead areas. If the subject is standing to
the right of centre, they should look left, into the picture.
Conversely if they stand on the left, have them look right, so
that the viewers’ eye follows the subjects gaze, and uses the

rest of the photo.

Now there are various creative ways you can interpret this. You
can lead the eye vertically through a picture, or even three

dimensionally, using different foreground and background levels.
If you want to place someone in the middle, crop right in close

so that there is no wasted area.

Also, unless you are cropping close and being clever with the
lighting, don’t have the subject stand flat to the camera. It looks
static. Angle the body. This is where the next variation comes
in. The subject stands left of centre, but looks directly at the
camera. You make this work by angling the body so that the
front points across to the right of the picture, leading the eye
across. The further off centre the subject goes though, the more
obvious or extreme the head or body positioning needs to be to

direct the eye back across into the rest of the picture.



In this shot the subject stands right of centre, and while she is
looking at the camera, the body is angled so that it leads the

viewer into the left side of the picture.



At first glance this picture could seem problematic as the head
and arm are in the top right corner, looking straight out of the
picture. However, it works because the body is angled from the
bottom left so that the eye travels up from bottom left to top

right, using the length of the photo.



Here’s a much better composition. The gun leads the eye up
the photo, the back is resting on the right side and the gaze is

looking across to the left, while the background is a pleasing
blur from using a wide aperture.
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Finally, here the subject curves across into the middle of the
picture, but this works because the hay bales in the background,
despite being diffuse, clearly lead the eye to the right and into
the distance, so that both the space to the right is utilised and
also that there is depth into the photo as well.



APERTURE CONTROL

One of the key elements in portraiture is using aperture to set
the depth of field. For this reason, when using natural light, it's
best to use the camera in AP, aperture priority mode. Certainly,
you should not use Program or Automatic mode when taking
portraits as this leaves the aperture control to the camera, and
it will not use the best setting for your portrait, it will use
whatever is best to get a correct exposure. For compact cameras
where there is no specific AP mode, set the camera to Portrait
mode as this will tell it to use the widest aperture available as

well.

The aperture range available is set by the lens itself, with longer
focal length lenses, having a more limited wide open aperture
setting, unless you spend an awful lot of money. For example,
with a somm prime lens, you can expect to have a wide
aperture of /1.8 whereas with a telephoto lens of 200mm it
could be f/3.5, f/4 or usually at best, f/2.8. Zoom lenses make

matters worse, losing f-stops at the wide open end of the range.

What it all boils down to is that the lower the f-stop number,
the less depth of field there is. Controlling depth of field is
important because it sets how much of the picture is in sharp

focus. The reason for limiting depth of field is to keep the



background out of focus so that it does not intrude on the
subject. In practical terms, this is more often a problem indoors
where objects such as lights, decorations, flowers or beams will
appear to join with the subject is there is significant depth of
field. Hence you get the object sticking out of someone’s head

look.

This is a real problem for compact digital cameras because they
generate much more depth of field at each aperture than a
digital SLR lens. The effect can be minimised somewhat by
moving the subject as far away from the objects in the
background as possible. As longer focal lengths have less depth
of field than shorter ones, it is also possible to minimise the
effect by standing as far away as possible, and zooming in. That
creates much less depth of field than standing in front of

someone.

Now, a word of caution. Shallow depth-of-field is a great thing,
but if you are using something like f/1.4 or f/1.8 then you really
do get very little depth of field. If you focus right in on a
subject the depth of field can be so shallow that one side of a
face is in focus and the other is out of focus. In these
situations it is advisable to focus on the eye of the subject that
is the most important photographically — there’s no rule to say
which one, because it all depends on how you composed the

picture. But the overall objective is the same, ensure that the



most important eye is in sharp focus so that the viewer's
attention can fix on it, and everything else can go out of focus.
Alternatively, if you are cropping right in close, use a slightly
higher f-stop to create a little bit more depth of field and

ensure the entire face is in focus.



In this photos, | have deliberately included more of the
background in the top of the photo to illustrate the point. With
too narrow an aperture, the background is in sharp focus so
things appear right out of the back of the subject’s head. To

make it all worse, the light is on and makes a massive halo



above her head. Use a smaller f-stop number, turn the light off
and make the subject stand a little further away from the

background.



This picture uses an aperture of f/1.8, creating very little depth-
of-field. As a result, the point of focus was aimed at the right
eye, as that was closest the camera and the most important.
That eye and the side of the face nearest the camera are then
in focus, with everything else going out of focus. The f/1.8
aperture means the background is nothing but a pleasing swathe
of pale green.



CHAPTER 2. GO INTO THE STUDIO

The prospect of studio shooting is quite daunting if you've never
done it before, however, it's neither as expensive, nor as difficult
as you might imagine. There are lots of photographers with big
studio spaces and when they aren’'t using them, they sit empty.
Rather than that, they like to hire them out. Studios that use
state of the art equipment, in a trendy part of a capital city are
of course overpriced and you would be better served avoiding
them completely. Cast your view around though and it's possible
to pick up two hours of studio time for £50/$75, which includes
using all their lights, props and backgrounds. Some studios are
specifically set up to cater for the enthusiast and have both
good deals and actual sets created for you to use. Also, being
inside in a secure workspace has other benefits if you want to
try glamour or nude photography, but even for portraits, you will
have no trouble booking models on a TFCD basis if you giving
them time in the studio as well. What you do with the time
and space is down to you, and hopefully, the other chapters in
this book will give you plenty of ideas. For now though, this
chapter deals with the practicalities of how you actually use your
DSLR with studio lighting.

HOW TO METER



When you first get to grips with photography, you learn that it's
all about aperture and shutter speed, so a trip into the
photographic studio can come as a shock. For a start, your
usual in-camera metering process is now of no use at all unless
you are using a continuous light source. Camera-based metering
reads available light before you take the shot and gives the
camera the aperture/shutter settings. This is fine for regular
photography, or tungsten in the studio, but it doesn’t work for
electronic flash because the flash is only activate when the
camera fire button is pressed and it only lasts for a very brief
instant. So, instead of in-camera metering, you need to use a
light meter that is connected to the flash lights — either by

cable or infrared trigger.

The other point that can be confusing is that you will often
hear it said that the shutter speed is irrelevant. While this isn’t
true, it does lead to a special set of considerations. The starting
point in most instances is in ascertaining at what shutter speed
the lights and camera can synchronise at. This means that when
the fire button is pressed, the flash fires at exactly the same
time. Usually it's 1/125th sec or 1/250th sec. Some cameras and
lights, particularly modern DSLRs, can synchronise right down to
very slow speed, but 1/250th is usually the fastest they will sync
at. Now, this is where the comment about shutter speed being
irrelevant comes from. It is used to sync with the lights, but as
also hinted at, you can use it at slower speeds to create mixed

lighting exposures. This then is the key point. With apertures of



around f/11 and a shutter speed of 1/125th sec or 1/250th sec,
the overall exposure is insufficient to record the background or
ambient light. So, the only light recorded is that from the
electronic flash itself. With no background light being recorded,
the lighting in the picture is exactly what the studio lights are
set up to create. And that's all down to you. Here's how to do
it.

SHOOTING IT

There’s an important point to realise first, and that is that the
power setting you dial into the flash unit is not the value that
is used on the camera settings. Power settings on electronic
flash either use general fractions, such as quarter power, half
power or full power — and it's down to you to know what that
full power setting actually is, or it uses actual f-stop ratings for
power. As mentioned, just because the lights say f/22, doesn’t
mean you enter that into the camera because there are three

things that modify this power setting:

1. What kind of diffusion you are using on the front of the flash
unit. No diffusion gives the strongest effect with harsh shadows,
but a softbox, reflecting dish or brolley will all reduce the power
of the light heading towards the subject. The reason for using

them is to soften the flash, so that there are no harsh shadows

on the subject. This is one huge advantage over a flashgun or



built-in flash — the larger the diffusing area, the softer the

shadows are as a result.

2. The distance to the subject affects the brightness of the light.
This works on the ratio that as the distance from the light
source to the subject doubles, the amount of light reaching the

subject halves.

3. Overlap of lights will increase the power reading and intensity
at that point. You don’t have to use just one light in the
studio, you can use lots at once, and that's the other reason
you don’t just use the power setting on the lights themselves,

you need meter the light falling onto the subject.

So, most important point, when shooting in a studio with
electronic flash, you will need a hand-held light meter. If you
don’t have one, the studio almost certainly will. Just make sure

before hand and that you have spare batteries for it.

The best way to proceed is to identify which electronic flash unit
and diffuser you are going to use as your main light. This is
known as the key light. Set it up in a typical position in the
studio space and connect your light meter to it. Some light
meters will require connecting to the key light by use of a cable
— again, the studio should have lots of these. Other light meters

have an infrared trigger that will fire the lights without the need



for cables. The advantage of using cables is that it will always
fire, the disadvantage is that you can trip over them or they
aren’t long enough. A meter with an infrared trigger is usually
better, but has the disadvantage that the flash has to be in line
of sight in order to trigger.

SETTING THE LIGHT METER

Most light meters have numerous modes. You want to set it to
Cord or infrared trigger mode, if it has one. This is the mode
the meter using to connect to studio lights, so read the manual
and see which one it is. Having selected the right mode, you
then need to enter the shutter speed at which the camera and
lights will synchronise. This is usually 1/125th sec, but set it to
what the camera is set to. Usually, you set the camera to the
sync speed of the lights, only if you are trying something fancy
with ambient lighting as well will it need to be anything else. To
get started though, you need to set the camera and the meter
both to the speed of the synchronisation of the lights, typically

1/125th sec as mentioned.

The light meter will usually have a receiver globe as well. With
the globe across, covering the element, this is set for light
hitting it directly from the electronic flash. With the globe slid
back to expose the receiver element, it is used for light

reflecting off surfaces — just like the in-camera metering. For



your purposes, slide the light globe over the receiver so it is

covered.

Now, to actually use all this, go stand in the spot where your
subject is going to stand. Hold the light meter up at around
face height, pointed towards the key electronic flash unit and
press the light meter fire button. Check the reading on the light
meter. This will give you a typical f-stop value to work with so
you know what settings to use on the other lights. There are
usually lots of different modes on a light meter, including EV
readings, but the most useful mode is one where it syncs to
the lights and gives you a power reading in terms of f-stops. As
mentioned, because electronic flash is all over in a brief flash,
the shutter speed is simply used for synchronising with the

camera.

Fast forward now to when you are setting up a shoot with a
subject. You can introduce them to the studio and get them to
stand or pose in your preferred spot. Still keep the meter
connected to the key light. Note that where the light from the
key light falls, it will be well exposed, and where it doesn’t there
will be shadow and darkness. As explained early, because the
settings used are much faster and narrower than normal, the
ambient light won't be recorded, or if it is there won’;t be much
of it. Just because you can see clearly in the studio doesn’t
mean that the camera will record it. It will only record the light
from the studio lights. Other lights are known as fill lights and

the idea is to use them, either at the same strength as the key



light, so that you get an all-round balance of lighting everywhere,
at a lower power, so that those areas are slightly darker and
you get shadow definition, or brighter so you get highlights.
Typically, small spots or lights with a conical attachment known

as a snoot, are used for lighting the hair.

Okay, so now add any secondary lights for filling in light on the
other side of the key light and hair lights or spot lights for
effects behind the subject or creating highlights on the hair.
When the meter triggers the key light, sensors in the other
lights will detect it and trigger at the same time as well. So,
you only have to fire one light at any point, either with the
meter or the camera. All other lights that are powered up, will

fire when they detect the key light firing.

When all the lights are set up that you want to use, check the
light readings at various places on the subject simply by
pressing fire on the light meter. The light will be different in
different places. Adjust either the power or the positioning of
the lights until you are happy with the arrangement. Then get
the meter reading from the area of the subject that forms the
key part of the exposure — usually it's exposed to the key light.
Now, this is the important part. When you meter the lights,
determine yourself, what should be the middle part of the
exposure in the camera. Typically, this is the reading from

holding the meter up in front of the face. This meter reading



will form the middle part of the exposure. Anywhere else on the
subject that has a lower light reading will be darker, anywhere

that has a higher f-stop reading will be lighter.

Go to the camera and ensure it is in Manual mode. Connect
the camera instead of the meter, to the lights. Again, you can
use PC sync cords — the same one as the meter used, or you
can use infrared triggers that slot on the top of the DSLR where
the plate for a flashgun goes. Dial in the synchronising shutter
speed — typically 1/125th sec as mentioned, and then the
aperture setting that the meter revealed for the middle part of
the exposure. You are now ready to go! Focus on the subject,
get them to use the desired expression and fire away. You do
not need to meter again or change any of your settings, until

you move or change the settings on the lights.

Depending on the quality of the studio lights, they will recycle
and power up quickly or slowly. If you fire before they are ready,
then that image will come out black. Just work to the speed
that the lights allow. Some lights will plug directly into the
mains, professionals tend to use heavy duty power packs that
can recycle the power much more quickly so they can shoot a
lot faster.

TOP TIP



Use a small studio light which projects a narrow beam of light
thanks to a modifying attachment like a snoot and aim this at
the hair. Set this to be one f-stop brighter than the key light.
This will introduce highlights into the hair because they light
there is brighter than the key light.



TYPICAL STUDIO SHOTS

Okay, so you've read the theory, you want to see it in practice

so let’s have a look at some studio shots.




This is a standard lighting setup that you would see in
unimaginative high street studios. Why? Because it's two lights,
at 45 degrees left and right, same power, pointing into the
middle. It provides all round lighting coverage and once set up,
you don’'t need to waste any time changing anything. The
subjects can roll around in the middle and the image will be
well exposed regardless. The only variation here is that there are
two more lights, firing at the background, at a higher power, so
it's completely white and throws back a little more highlighting

onto either side of the dress.



On this shot there are two main lights again, one slightly more
powered than the other, but they have been move all the way
around to the sides, so that the middle of the subject facing
the camera is darker. The key light is to the left, the fill light is
on the right.



Here the key light is on the right and is angled so that it
covers the subject and also some of the background. The light
on the left is smaller, but just as powerful and is aimed higher,

at the upper torso of the subject.



For this studio shot, there’s a bit more work involved. The key
light is on the right at an angle. There's a hair light from above
on the left, and there’s a fill light on the left, pointing at the

chest.



A satin fabric dress reflects the light nicely. Again, key light to
the right to illuminate the back, there’s a hair light from almost
directly above, and a fill light from the left to provide definition
on that side.



Time for some fun. Firstly, the model was asked to bring a

reflective dress. There's a light at the front, just to the left of
the camera. This formed the meter reading. Behind the model
was a fabric curtain. There are two lights behind this, pointing

towards the camera, set at full power. The result is a halo



behind the subject, coming through the fabric.



CHAPTER 3. FASHION PHOTOGRAPHY

The odds on making it big as a fashion photographer are only
slightly better than those for winning the jackpot on the lottery.
Even 95 per cent of all photography graduates are working in
other fields five years after completing their courses. To get your
foot through the door you must either strike it lucky coming out
of college or wangle an assistant job with someone well known,

and then make the breakthrough when you leave.

However, the overwhelming unlikeliness of you turning into the
next Rankin or Bailey shouldn't dissuade you from adding a
touch of fashion style to your portraits. A great source of
reference for images are women’s magazines such as Vogue for
high end fashion and Cosmo or the fashion colour supplements
of the Sunday papers for more regular styles. If you want to see
a real stock of high fashion ideas, try to pick up a copy of

Italian Vogue as it's more like a fashion bible than a magazine.

There’s an almost endless variety of styles and concepts you can
come up with, though fashion model poses tend towards
miserable and aloof, ungainly and deliberately disinterested. The
counter point to this is where you strike specific poses to
accentuate particular features of the model or the clothes. You

can shoot in the studio or on location, whether that’s inside or



out. That also means equipment can vary from DSLR and studio
lighting to simply a good quality compact and a model with
great clothes who can pose.

To get some ideas for this category, magazines such as Vogue
and Cosmopolitan, or the Sunday papers colour supplements will
have lots of latest styles.



MEAN AND MOODY

The ethnic or peasant look usually has some mileage, though
pay attention to short-lifespan fads that are popular one season
and gone the next. Unless the images are for a specific
commercial purpose that needs that cutting edge, then more
general images will be able to stay in your portfolio for a lot
longer without dating it. Some styles and variations stay current
for a decade before being replaced, while others will blow hot
then cold in only a year. Fortunately at the moment there is a
very wide range of clothing styles on offer, as well as vintage
revival going on, so there is plenty of latitude. Going with a
vintage style is actually a safe bet as well because it is clearly
aimed at replicating that specific era, and therefore cannot, by

definition, go out of fashion as such.

For this shot you need a skirt with plenty of pleated or frilly
cotton and, preferably, a white cotton blouse with some ornate
detail. Aim for the model to look miserable. On no account
must the subject smile or look slightly pleased with the prospect
of being photographed. However, avoid veering into a parody of
Oasis-like photographer antipathy, just stick to moody and
melancholy, get the model to slouch and affect a couldn't-care-
less attitude. Shadows are important, as are areas of darkness.

This can be shot in a room, on stairs or in studio.



If you're using a flash then one electronic flash head, placed off
to the side to generate shadows behind, will suffice. Use a
reflector to add definition and bits of highlights to the darker
side. Use a narrow aperture like f/16 or f/22 with the flash on
full power to get the rest of the room to descend into darkness.
If using natural light then use a narrow aperture to reduce the
background light, and use reflectors to keep the main subject

brighter than their surroundings.



The subject looks miserable and moody, she hunches up and

lets her hands dangle, though they tend towards the unwanted
bunch of carrots look



Here’s the same kind of pose, all disinterested to the extent
that the model isn’t even looking at the camera. This one is on
location, and a grubby location at that, so the only light here is
from a large window. A portrait lens of somm was used at f/1.8
aperture so there’s little depth-of-field. An ISO of 200 was



needed just to keep the shutter speed up to 1/60th sec.

On location again, this time with an interesting alley. While the
model is now looking at the camera, the body pose is even

more ungainly while the miserable look is played to perfection.



Again, the portrait lens of somm was used at f/1.8 and because
of the very gloomy conditions and ISO rating of 1250 was

required to get the shutter speed up to 1/50th sec.



MAD AND MODERN

When your subject is wearing modern, vibrant clothes, the
photography should follow suit. Go for expressive poses, use
coloured spots — whether from gels on inexpensive flash heads,
or simply by shining coloured bulb lamps at the subject. Also
consider shooting at angles to emphasise the dynamism of the
subject and if the subject has long legs, then exploit the fact
and shoot from a low angle to make them seem as if they go

on forever.

When using studio flash then brightly lit is the key. While some
shadow definition stops the subject from being flat, the entire
scene should look bright. If using coloured lamps in conjunction
with flash, take a flash meter reading, put the camera into its
aperture priority mode, and use the camera to take a meter
reading. The speed setting that it comes up with will allow the
exposure to record the lamps. Set the camera into manual mode
as usual, dial in the aperture from the flash meter and the
speed from the second reading. This will inevitably be much
slower so the model needs to keep fairly still unless you

deliberately want to record some blur.



Shooting from a low perspective at an angle creates a dynamic

look that emphasis the model's long legs



Note the use of coloured gels on the side light here. The key
light is also aimed at the wall to provide a highlight on one

side and darkness on the other.



The key light here is actually pointing behind the model at the
backdrop, making it brighter than the fill light which is used on
the model herself. The result is a bright halo, ideal for

emphasising the hair and black gloves.



For this shot we're out of the studio and onto the streets. This
is very much a lifestyle fashion image showing the model being
happy. Shot at dusk to get all the street and shop lights it
required an aperture of f/1.8 and an ISO of 800 to just get a
shutter speed of 1/25th sec, which is right on the limit of what



you can do without a tripod.



HIGH KEY

The staple diet of student photographers everywhere — and for
good reason, it makes for an effective and graphic photo. The
subject should be wild and wacky, the make-up should be as
bright and glaring as possible, without looking like Ronald
McDonald. Attitude and posture from the model are key.

This type of head and shoulders shot works better if the subject
has bare shoulders. Don't have the model face directly at the
camera unless she is doing something else, like pulling her hair

out.

Blast the subject with light. If you don't have a studio flash unit
then use natural sunlight, diffused through netting, or bounce it
back onto the subject using a reflector. However, don't have the

subject stand facing bright sunlight or they will be squinting.

Take a meter reading and open the aperture up one stop (lower
the f-stop number). In film photography the idea would be to
completely overexpose the subject, but digital imaging offers
much more control so simply produce a bright-white image,

rather than one where most of the detail has gone.



A

A more traditional high key look. This was shot to be bright,
then Curves in Photoshop was used to whiten out areas and to

increase the contrast in the detail areas.



STYLISED POSES

For the next couple of shots there were specific stylised ideas to
shoot. The first uses the subject in a bright red, shiny, evening
dress with matching choker. It's a combination shot, using flash
for the model and ambient light for the background. This is
quite a tricky combination and it depends on how much control
over your flash gun or source that you have. The simplest way
of doing it is with a flashgun and knowing what speed it usually
syncs to the camera at. Here it was 1/6oth sec. So, a meter
reading for the background light was taken, with a shutter speed
setting of 1/60oth sec and that gave an aperture setting of f/2.8.
The camera was then turn on to manual, with those settings,
and the flash was set to on. With a modern flashgun, it will fire
enough light to match the exposure settings and then stop.
More sophisticated flashguns will offer more control, and old
ones less, but this is okay because they simply have power
settings that you can set. If you are using on-board flash, simply
use the settings as read and make sure the flash is set to be
forced to fire. Then the flash illuminates the foreground and the

ambient light illuminates the background.



A tricky mixed lighting shot, with a stylish evening dress and

lots of editorial interest.



This shot was a location based shoot in a wood and was
intended to depict a country or rural fashion aesthetic. Location
scouting for an area with trees and a path that led to them was
done the week before. The model was prepped with rural

clothing requirements which included the boots and hat, and we



picked up the stick while there. It's a wide aperture shot of f/1.8
using the somm portrait lens at 1/g9oth sec. The ISO rating was
100 but -1EV exposure compensation was used to stop

highlights on the cardigan and hat from being lost.



CHAPTER 4. GO GLOSSY

How to shoot stylish portraits in upmarket location

While this type of photography is ideal for Christmas what with
parties, restaurants and dressing to impress, it's also perfectly
applicable for any kind of location-based shoot where you want
an up-market image in an out-of-the-studio setting. In this
feature you can go for creative lighting with portable studio kit,
or rely on natural light, reflectors and the photographer’s friend,

Photoshop.

MATERIAL GIRL

The idea of this shot is to simulate the effect of reflective fabric
flying behind the model who is wearing a satin, reflective dress,
without recourse to a wind machine or a trip to somewhere
very, very windy. All good and well if you do have a wind
machine and a nice background to stand the model against, but

otherwise, here’s how to create this dynamic look, the easy way.



Firstly find lots of spare room on the floor. If it's a wooden

floor, either arrange the subject so that they follow the lines up,
or lay across them, so it gives a background like a log cabin.
Next, set up the main light to hit the face, fabric and top of
the subject. If you have another light position that on the other

side to light up the legs. If not, use a reflector in that position,



which is what was used here.

You need to stand above the subject — a stepladder is the
safest thing. A chair will create a more extreme effect than

standing on a table, though is obviously easier to do.

Stand at the end where the model’s head is and look over and
down the torso for the shot. If you stand anywhere else it will
show up the neck area and even on skinny subjects, this
doesn’t look good. Fire away, then head for Photoshop or
PaintShop Pro or GIMP.

1. First select all around the subject. Don't feather the selection
because any subsequent hue shifts will affect the feathered edge
as well, giving a line around the subject. Invert the selection
and select Filter> Blur> Motion Blur. The angle is set to match
the general direction of the wood, and a value of 25 pixels
should be good enough to generate movement blur, without

turning the background into paste.

2. With the background still selected, go to Image> Adjust>
Hue/Saturation. Pick reds and use the sampler to click on the
wood. That should target the colour properly. Then use the Hue
adjustment to shift it so that it contrasts with the colour of the
fabric. Also try to pick out a colour from the outfit — in this

case a light purple colour.



3. Reduce the saturation of the background so that it separates
from the foreground, then invert the selection. Now select
Image> Adjust> Curves and enter an S-shape curve to boost the
contrast, shadows and highlights of the main subject. Flatten the

image then crop to the desired shape and save.

CROSS PROCESSING

There’s a technique in the film world known as cross processing
whereby slide film is developed in print film chemistry and vice
versa. The effect of the chemicals is that some colours stay the
same while other undergo startling hue shifts. The exact effect is
not predictable, and much film and potions are usually required
to get a decent result. When it does come off the effect can be
arty, surreal or simply very pleasing. Simulating this in a photo
editor is equally not an exact science, but experimentation is
easy if you follow this technique. It's also worth looking at a
number of film filter or retro plug-ins like Alien Skin’s Exposure
5 that offer this kind of treatment. Anyway, this is the process

for most versions of Photoshop.

1 Take the original image and create a new Adjustment Layer
using a Gradient Fill. Don’t worry about the exact one just yet.
Whatever you choose the effect is likely to be too over the top.

Change the Blend mode to Colour and reduce the Opacity to



50%. This will make it much more palatable.

2. Double click on the gradient map in the Layers Palette to
bring up the gradient being used. Click on the small arrow
facing right, underneath the gradient to bring up the various
categories of gradient. The pastel ones tend to be very subtle
and suit lighter images, the metal ones very vivid, and require a
different blending mode to be anything other than garish. Select
a gradient that contains one of the colours already present in
your image, and go through those that do to see what effect is

most pleasing.



The final cross processed image with a range of purple and

yellow tones



BACK LIGHTING

If the sun is shining and you get your subject to stand against
a window, then invariably they will turn into a silhouette. There
are two ways of dealing with this. One is to balance the
exposure so that there is as much light in front of the person
as there is behind, and the other is to exploit the effect, while
still making the person visible. So how do you do it and still

make the picture look glossy and lovely? Read on...



Halo Effect

In this shot the background is very bright, forming a halo effect

around the model’s head. Also there is a pleasant colour cast



from a large tungsten lamp to the right. An aperture of f/4 was
set to ensure that the background disappeared out of focus — if
it could be seen. Then, in Aperture Priority mode, spot metering
was used to meter just to the right of centre of the girl. The
exposure time of 1/8th of a second was what was required as
the middle part of the exposure range. This was where the
tungsten lamp light was falling. By setting the Automatic White
Balance to 6600K (or bright day/ bright cloudy day on your
camera) as well, it also meant that the colour from the lamp

would register.



Balanced Exposure

The tungsten lamp was dispensed with and a portable flash
head with a softbox set up to the right of the model. The



aperture setting of f/4 was retain for the same reason it was
used in the first place, and the flash head set to quarter power,
which also gives a reading of f/4. To get the background to
match, the camera was set in Aperture Priority mode, the f/4
aperture dialled in and spot metering used to take a reading off
the cloud/trees level with the model’s head. This gave a shutter
speed setting of 1/250th sec. The camera was then set to
Manual, and 1/250th and f/4 dialled in. Hey presto, the

foreground and backgrounds are balanced.



PORTRAIT IDEAS

In case you still need some more ideas, here are a few others

for creating interesting and distinctive portraits.

Moody looks

The close up here runs the risk of distorting the leading arm,
and is also quite dramatic with the shadows across the face —

this is always useful when aiming for a moody portrait.






Here the subject is looking thoughtful and not at the camera,
while the bright splashes of sunlight light up areas in the
background.



Mysterious focussing

There are two ways of shooting this, both using a wide aperture
— f/2.8 was selected in AP mode. You can either focus on the
foreground, making those objects sharping, then the subject can
be seen pondering in the background. Who is she waiting for,
why is the room empty, who is that figure? Alternatively, reverse
the concept and focus on the figure, so that she is plainly
visible, but the out of focus table in the foreground sets the

questions.






Alternatively use a narrower aperture and place everything in

focus so that the viewer can see the subject and all the details
in the background.



Try some mono

Although it might seem a little odd to go mono in such a

colourful surrounding, it's always worth trying to see if you can

get something different out of the shoot.




With so much light coming in, there are areas where you can
use shadows to break up the background and add some mystery
to the face.



CHAPTER 5. SHOOT LIKE BAILEY

Learn from the masters with David Bailey’s ground-breaking

portrait techniques

Like the man or not, David Bailey is something of a legend in
portrait and fashion photography and you don't reach that
exalted status without having a decent slice of original talent.
What this article aims to do is not recreate Bailey pictures from
years gone by, but to distil some of the signature technique
styles so that you can apply them to you modern portrait shots,
whether you have cheap studio lighting or are simply using a

point and shoot compact.

MODERN PORTRAITS

You don’t realise just how influential Bailey has been until you
look at the years of portrait photography that followed. Here we
are looking at the most instantly recognisable technique style

that requires nothing other than good lighting. Then we have a

variety of poses that need one directional light source.



1. The crop head shot. Classic Bailey and still popular today.
Aim to get close in to the head, some space on either side is
allowed, but the top of head should be cut off. The reasoning is
so that the attention is drawn to the eyes and face. You can
look happy or glum, it’s applicable to all.



2. With moody looks and peasant blouses always popular, this
style is worth pursuing. You need one light that is positioned
high above the model and at 45 degrees to the right. This is
the classic loop lighting of the 30s but the twist here is to get

the model to look all mean and moody and have a fan blowing



like mad at their hair.



3. There are two varieties of this next position. The light needs
to be at head height and 45 degrees to the model so that some
of one side of the face is in shadow. The forehead will remain
clear, one side will be perfectly lit, but the shadows and light on

the other side add depth and interest. Either shoot a close up



like here.



4. Or pull the camera back and get a top half shot like this
one. Once again, the play of shadows across the right hand side

of the torso stops the image from being flat.
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5. Now let's look at a real extreme technique that Bailey used
on mainly his male sitters, but some of the female ones as
well. That 45 degree sideways light has now been moved all the
way around to the side — keeping the height the same — so that

only one side is lit and the other is in shadow. For this look



your victim should look pensive and moody.



6. A final style type is quite subtle. The light is just off centre
and just above the model so that it pours light down on to
them. The allows the model to move around, but would usually

be looking at the camera.



GOING RETRO

If you fancy moving on from straight portraits you can have a
go at 60s retro, either obviously so here with our Mary Quant
outfit, or with gypsy tops and lots of flowing lace. Look to get
poses with sprawling limbs and making angles with arms or
legs. Affected poses such as with the head resting on hands or
tucked behind the head are also fun to use. Check out the
individual poses to try out. All of these shots were done with
two flash heads, pouring light into the scene. There is no
particular lighting technique beyond making sure that everything
is well lit. It's all about the pose and the outfit.



1. Archetypal cropped head shot, but this also includes the top
half of the body, leading from top left to bottom right and
leaving the right side of the frame empty.



2. A close up cropped shot with the model hugging a knee and
filling the frame. The body and leg make a pleasing shape
through the frame. The facial expression for all of these should
be pouty, aloof or with a hint of a smile. No cheesy grins for
this section.



3. The head looking back over the shoulder is a favourite and if
you do try this, think about focussing on the face and use as

wide an aperture as possible to get everything else to fall out of
focus. Given the natural ability of digital cameras to keep things

sharp you might want to add a bit more blur on the PC.



4. The extreme version of the last concept is the model looking
at the camera while upside down. If you can shoot this one in
a crowded bedroom or messy flat then even better, but
remember, you must have a wide aperture for this style of on-

location shot so that the messy surroundings go out of focus.



DISTRESSED COLOUR

No roundup of Bailey techniques would be complete without a
mention of his penchant for distressed colour shots. Harking
back to his fondness for masks, here the mask is over the
portrait itself, where a typically single colour is applied with a
distressed effect. This is particularly easy to do in Photoshop or
PSP so one of the shots from the studio was given just that
treatment. Note that you'll need to reduce the number of tones,
particularly from the mid-range — so use Curves or

Contrast/Brightness quite harshly.






CHAPTER 6. CLASSIC HOLLYWOOD

Bring back the golden age of studio portraiture in Hollywood.

Back in the 1930s and 40s, movie stars were usually contracted
to individual studios for a number of films and years. To better
promote their stars and increase interest in the films they
featured in, the studios spent a lot of time shooting their
portraits. While a number of these were on-set, there were also
even more with elaborate settings and the fact that the
photographers had access to endless lighting equipment meant
that shots varied from fairly simply to very complex. Technology
had rapidly developed from the 1920s, resulting in much higher
quality photography that really helped promote the stars, films

and studios.

At this time there were no such thing as electronic flash, the
photographer had to work with large tungsten lamps and heavy
cameras, resulting in long exposures as on the set there was
little or no natural light. So the subject generally had to adopt a
relatively relaxed pose that was easy to hold. By the 1950s,
faster films and lenses were common place and portraits
become far more action orientated, with less emphasis on
complex lighting schemes and style, but that’s what Hollywood

portraits are all about.



The advantage of using tungsten lamps is that you can see
exactly where the light is going to fall, before you take the shot,
and indeed, this is how it would have been shot at the time.
Tungsten is a continuous light source, whereas electronic flash
is very brief, and while electronic flash units do come with
modelling lamps, they are not as accurate. It meant that back in
the day, very precise arrangements of lights could be made
around the subject. These days, we tend to use electronic flash
for the higher colour temperature that corresponds with mid-day
daylight, rather than tungsten lighting, though there are some
units around. You can still use your flash gear for this type of
photography, but the softboxes and brolleys that did the
diffusing need to be dispensed with. Instead, harsh, direct
lighting is the order of the day.

THE 1920s

There is no particular lighting style that would instantly identify
a 20s shot, as you could with a 30s or 40s, but the cameras
and film were a lot cruder. What you need to consider are the
fashions and styles and what the resulting images would be like
when printed. The first thing to start with is the pose. These
really did have to be comfortable because the exposures were
longer than the other periods and often you would get soft or

blurred images. And that’s before you had the poor quality



lenses. Also, quite a few of these images would have been shot
with natural light, let in through skylights, as well as the heavy
tungsten lamps.

Style wise there were often ethnic or exotic elements included,
particularly Egypt and Arabia. Short hair in bobs or with fringes
and nets, flowers and other accessories were popular. For the
gents, the hair is pretty much slicked back and you may include
a moustache or two. Of course, flapper dresses were very
fashionable and although this gives the impression that all
outfits were one-piece and straight up and down, that isn’t the
case. There are lots of historical photos of two piece outfits with
knee-length pleated skirts, which were of course, ideal for
dancing. Other notable features include the distinct -curl of hair
on the forehead, heavy eye makeup and the pouting-kiss lip
makeup. It's important to note that there was a big difference
between what young women wore and the much more formal
attire of the middle aged and elderly.

What you really need to pay attention to is post-production to
ensure a real lack of sharpness and contrast that the lenses of
the day delivered. Add vignetting, paper textures and sepia for
an authentic finish. While old techniques such as Calotype and
Daguerreotype are offered in a number of photo-editing plug-ins
bear in mind that these processes had actually stopped being
used by the 1870s.



A typical 20s style shot. Note the very soft image, the blown
highlights, the out of focus vignetting. The style of the subject
as well features large eyes with eye shadow prominent. A bob-
hairstyle and lots of ethnic patterns on the gown fabric and in
the background.



The important points to note here are the style of the fringe,
the blown highlights, the fading of the corners and the
puckered-kiss style of makeup on the lips.



THE 1930s

The signature lighting style of the 1930s was called loop lighting.
In this the key light was placed at 45 degrees to the side of the
subject and 45 degrees above, so that the shadow caused by the
nose went down diagonally to one side. Of course there are
variations, but this is a key lighting style that will identify the
picture. The styling of the day, for women, was straight hair tied
back or straight hair with a curl at the shoulders. Now, bear in
mind that skin and red tones were rendered quite dark on the
films of the day, so the men tended to look a little swarthy, but
the women wore lighter, whiter makeup. You don’t really have to
worry about that at the shooting stage, but at the colour to
mono conversion point, ensure that any red lipstick used comes
out quite dark in mono. Lenses had improved from the 20s so
not as soft and there was more contrast. Sepia was still used,
but a lot less. Instead, photographers now went to town with

lots of lights, creating areas of dark shadow and light.



This is a modern reshoot of a classic 30s Hollywood pose. Note
the black glove emerges from a dark area and is clearly visible

against the white background. Note too the nailed on 30s loop
lighting effect on the nose.



Black gloves again here and one key light and a fill light. To be
honest, this really needed a fill light on the right hand side as

well.



THE 1940s

The signature lighting style of the 1940s was something called
the butterfly lighting effect. To get this the key light needs to be
directly in front of the subject but 45 degrees above, pointing
down. This will produce a shadow directly under the nose, in
the shape of a butterfly. This technique also tends to mean that
the eyes can be left in shadow, so fill-in lighting or a reflector
should be used to ensure that some light goes into the eye
area as well. Styling wise, hair was now fuller, as were eyebrows

and lipstick.

Developments in film stock meant that red colours were now
rendered more faithfully and not as darker. Exposure times were
shorter, so if the subject was laying down, it was because that’s
the pose they wanted, not because it had to be like that.
Whereas in the 30s shots, you'll see a lot of people leaning on

props, in the 40s, it starts to move away from that.

There are also types of 40s shot, from modern daywear to
glamorous evening wear. While most stars were dressed in their
best frocks, you also could see some regular 40s fashion shots
using afternoon or tea dresses as well. Accessories are also
important in this era, from handbags to jewellery. The other

style from the 40s came in towards the end of the decade with



the popularity of film noir. While this is not classic Hollywood
portraiture, you did see it start to creep in, and if the star was
in a film noir then they were definitely going to be shot in that
style. The idea with noir is to use unusual angles and dramatic
lighting to suggest a sense of unease and danger. The lighting
would often be from below, which, and you really need to take

this on board, is not attractive for the subject.
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The first shot here is a traditional 40s setup with key, fill and
hair lights, plus plenty of overt styling.



A sultry look that has distinct butterfly lighting.



This shot departs from the usual 4o0s butterfly lighting style and

heads into the world of film noir.



CHAPTER 7. MOULIN ROUGE

How to shoot and then hand colour photos to capture the spirit

of Edwardian dancing beauties

Around 35 years ago a photographer called James Wedge made
a splash by taking risqué photos of girls in Moulin Rouge style
outfits in black and white. Some he shot in genuine theatres,
others were done in studio mock ups. He then printed the
results and painstakingly hand painted the prints. As you can
image, the process was torturous and one slip could ruin the
whole venture. Fortunately, with the advent of digital technology,
the entire process is a lot less painful and prone to disaster.
You also don’t need to have your very own theatre on hand

either.

How authentic you want to get with the look and feel of this
project is down to you and the availability and cost of an
appropriate venue. If you can't find a suitable venue consider
anywhere with a stripped wooden floor. Then take out the
modern artefacts with Photoshop afterwards. That's what we’ll be
doing here. If you can’t lay your hands on even that kind of
setting then the solution is to head for the home studio or
simply your spare room and attempt to remove the modern look

and replace it with a period feel. We've also had a go at that



as well.

As far as costumes go you'll find that with the success of the
Baz Lurhman film of the same name a few years back, most
fancy dress outfitters will have something suitable. It's just a
case of getting someone into the outfit which either means your
nearest and dearest or a couple of hours of a model's time.
One thing you don’t have to worry about is that automatic
white balance which can go awry indoors, because you'll be
converting this all to black and white to start with. What you do
need to try and ensure is that you get as much light onto the

model and the outfit as possible.

As far as posing goes you can either go for the louche look
which is a mix between dancing girl and lady of the night, or a
more formalised stage pose. In the case of Mr Wedge his
photos were erotically orientated so featured nudity and much
more risqué poses. One of the classic poses to attempt is that
of the girl sat on the edge of the stage with lights shining up
from below. As we'll see, get the pose right in the first place

and then attempt to do the lighting in Photoshop.



SELECTING THE POSE

1. We are looking for a main shot to construct wooden
panelling behind. This isn't bad but the focus is too soft and
there is little detail in the hair.



2. A more energetic pose but the camera snaps while the model
has her eyes shut. Also, her hair disappears into the feather

boa. So, wacky, but not what we're looking for here.



3. Another good pose and facial expression, complete with boots
up on a small ledge. This is the one that’s going to be turned

into an Edwardian music hall.



4. Nice coy pose with the boa, but the leg position is all

wrong. It could be used but the previous photo was better.



HOME BREW MUSIC HALL

So what if you don’t have a handy foyer or accommodating
local hotel with stripped wooden floors? Well you shoot it in an
ordinary room like the original for this section and then you
find some wood — the pieces used here are actually from my
bathroom — and shoot them from the same angles that they
need to used in the composite picture. While the angles can be
distorted, that should only be done to fit the wood panelling,
not to force it into the right shape.



STEP-BY-STEP PROCESS

i muzic hall jpg @ 25% [RGB)

1. The first thing to do is to cut out our girl because she will
be the upper most layer. Use the Pen, the Selection or whatever
tool you prefer but don't worry about making a good job of the
hair — just cut round the whole barnet. Apply a feather of one
pixel and then make a copy by pressing Control-C and a new
layer by right clicking on the background layer in the Layers

palette and select New Layer via Copy.
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2. Do whatever cloning is required to remove things like corners
of beds and so on, but don’t waste time removing anything that
is going to be overlaid like the wire in the top right of the
photo. The load in the first of your wood textures. Start with
the one to go right behind the girl. Press Control-A to select,
Control-C to copy and the switch to the main composition and
press Control-V to paste as a new layer. Now use the Transform
Scale option to scale it into place.



3. Having stretched and placed wooden effects for the

background and footstool, the remaining surfaces can be a little

tricky. Mask off and copy then paste as a new layer anything
like pipework, and ensure that it is in the right place in the
layer stack. Now copy and paste some more woodwork. Where
it is for a plank at an angle use the Perspective distort to make

it look like it is getting smaller the further away it is.
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4. To simplify matters, select all the pieces of wood and ensure
that only they are visible. Then go to Layer> Merge Visible.
Where there are gaps between the textures, use the Clone tool
at 35% and clone from both above and below the gaps to fill
them in. This also breaks up the too-neat edges. Where a
vertical wall meets a horizontal surface use the Burn tool to

make the join look natural. Also use it to add slight shadows
behind the model.



5. Now for the tricky part of the hair. Select the girl on top
layer and the Eraser. Select a 25% opacity and start deleting the
yellow halo. Use gentle dabs inside the curl line where yellow
can be seen — just enough to start the background showing,
without the hair being lost. If you dab the main hair itself
simply back up one step and redo. Then work on the edge of
the yellow halo with a 33% opacity to remove it completely. To
finally remove any traces of yellow, and also, those bits around
the feather boa, firstly use the magic wand to select the empty
area around the girl. Invert it so you won't inadvertently paint
over the background. Now, use the Paintbrush with a Darken
blend mode and a brown picked up from the background. This

will not paint over black, but will colour in yellow.
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6. Use the Burn tool to add a little depth where natural
shadows would fall, in this case on the model's right hand side
and when done, merge all the layers and desaturate the entire
image. Now apply colour as detailed in the previous examples.
The final stage is to use the Filter> Render> Lighting option and
select a triple spotlight. Move them around and tweak them to

get a stage lighting effect. Save to finish.



——

Here's the final image, complete with some extra toning and a

period border from Alien Skin’s Exposure 5.



CHAPTER 8. VICTORIAN DRAMA

Use a combination of digital photography and darkroom

manipulation to create period-themed images

Working at home or in the studio is all good and well but
surely the most ambitious venture for the digital photographer is
to shoot a model out on location. As if that wasn’'t adventurous
enough, this article covers shooting on a particular theme as
well. In this case think Wuthering Heights, Mary Shelley,

Dracula, the Bronte sisters.... think Victorian gothic.

To the average digital snapper in the street this can seem
daunting to the point of precluding you from ever attempting it
yourself. Not so dear reader. If you have a decent digital camera
and by that | mean one where you can control both the
aperture and the shutter speed, then you are perfectly equipped
to mount your own location shoot. If you check out the panel
for what this actually cost us you'll see that we didn’t get much
change out of £400/$600 but it's also equally possible to do
the whole thing for under £50/$75. The reason why is to limit
the scope of the adventure and to take more time in getting the

elements required for free.



The first stage is to find a model. Check out your Thompson
Local or Yellow pages for an agency, or try the on-line versions
if you want a model based in another town. Go to
www.thomweb.co.uk or www.yell.com in the UK or try modelling
sites such as www.net-model.com or www.purestorm.com. Agency
models cost more money for the simple reason the agency
wants their slice of the pie. The good news is that they will
have lots of people on their books and you should be able to
choose from a selection for the face or body you want. Agencies
will also advise what type of modelling each person will
undertake. Alternatively keep an eye out for stories in your local
paper for new models winning competitions and get in touch
via the paper. Offer to shoot the model for free in return for
providing prints for his or her portfolio. Strangely enough, hair
salons will often know of someone who is moving into

modelling and will give you a lead.

To actually hire someone yourself the cost can vary enormously.
The model for this feature was Lisa Forster who didn’t have an
agency and she cost £180/$275 plus travel expenses for an
entire day of photography. If we had wanted nude work she
would have cost £200/$300. To help find a model who doesn’t
use an agency, and thus is also cheaper, you can do a few web
searches and also look in the back of photographic magazines.
However, the best place to look is on modelling websites. Here
you will find all manner of people who think they are going to

be the next big thing. Of course 99% aren’t, but it does mean



that you can find new or beginner models with either low rates
or, those asking for Time for Prints (TFP) or Time for CD
(TFCD). For these, all you need do is supply some pictures after
the event and you get your model for free. Bear in mind that
unless the model is local to the location then you will still have

to pay travel expenses.

The next stage is to sort out your location. This being Victorian
with a romantic gothic feel to it, Whitby on the Yorkshire coast
was chosen. This of course was one of the settings for Bram
Stoker’s Dracula. When deciding where you want to shoot you
should visit the site before hand to scout it out. Then, bear the

following points in mind:

(1) If it's far away, you'll need either to make an entire day of it

or stay overnight, and do the same again on shooting day.

(2) Who owns where you want to shoot? You may need
permission. Get the ball rolling early, get the name and phone
number of the person you need to speak to. Explain exactly

what it is you want to do.

(3) What will you do if it rains? Make contingency plans. Scout
some indoor locations. Or remember to pack an umbrella for

you and a towel for the model.



(4) How busy is it? Seaside locations in the summer can be
packed with tourists. You aren’t going to get a period shot

down cobbled streets in the height of summer.

(5) Where is the sun during the day? This may sound blindingly
obvious but it's no use hoping for a glorious sun setting over
the sea and heading for east coast. It sets in the west
remember. A caveat to that is that the actual sunset location
changes throughout the year, rotating through southeast, east

and northeast then back again as the year progresses.

(6) What time are you going to be shooting and in what
locations? Early morning the light is cool and sharp — ideal for
shooting vehicles and also mist and fog. At mid-day the sun is
directly overhead giving short, ugly shadows and running down
the face. Later in the afternoon the light is much warmer and
golden and you get longer shadows. Look for where these will
fall and plan your shoot accordingly. This is the theory mind
you, when | was in Whitby the sky was overcast, completely still

and a featureless grey.

For this feature | needed to get permission from Whitby Town
Council to use the art gallery and adjoining museum and then
the grounds of Pannett Park, in which these buildings are set.

After changing their collective minds three times, | was



eventually charged a £25/$38 location fee. Hardly worth it to be
honest, but it guaranteed me somewhere dry in case of rain and
a measure of variety. Also, the rose gardens were actually very

nice.

The ruined Abbey is owned by English Heritage and this
involved a paper chase before | eventually secured permission
the week before the shoot. As it transpired, | got permission for
free, which was handy because the site manager at the Abbey
told me they usually charge a location fee for weddings and
photography. So, go to head office like | did and cut out the

grasping middle manager.

WHAT IT COST

Lisa Forster — £215. Model hire for day plus expenses

Costume hire - £60. Three Victorian costumes for five days.

Accessories - £17. Wig and ear rings. Lisa provided brouch,

cross and alternative wig herself.

Location hire — Whitby Abbey (English Heritage) and Museum
(Town Council) both free but you would normally expect to pay
£40 to shoot at the Abbey and £25 to shoot at the Museum.



Transport costs - £35

Food and drink - £22

Total cost: £372/%$558

DOING IT ON THE CHEAP

How to save money: Use a new model on a TFCD basis for
free. Use a model with the same hair length and colour you
want. Choose a location nearby. Use fewer costumes. Don't eat
as much. Follow these tips and your total cost is likely to be

well under £50/%$75 although it will take you longer to organise.



SHOOT IT

1. Here we are in a museum, with our model looking like a
Sunday school teacher. Light levels were very low so a tripod
was needed. You also need to be care with the WB in order to

avoid a sickly colour cast, unless you convert it to mono, in



which case it doesn’t matter too much.



2. Outside with the ruined abbey on the hill. This shot uses an

open aperture to throw the background out of focus. Although
the model is positioned on the right and her body is angled to
the right, she hold the image together by looking directly at the

camera, leaving the viewer to explore the soft detail to the left.



3. A costume change and the white outfits compliment the
creamy stone of the abbey. A wide aperture ensures rapid fall

off of focus into the distance.



4. The horizontal parallel lines are good in this photo, but the
back of the abbey had some very distracting vertical lines from
the open window slits. Fortunately | had a step ladder with me
— yes, really, | packed it in the car! So, with the elevated

position the distracting vertical strips could be removed from the



composition.



5. Moving the ladder even closer enabled this high shot,

cropping close in to the subject.



6. While this doesn’t really work as it is, it can easily be
cropped to make it better. The subject is too central, there's too
much space above her head. Crop the top and right side to
have her look across the photo to the left.



7. This is possibly the best shot of the day. There's the interest
of the gravestone, the model shot close in holding the right side
of the picture together and the water and beach in the
background.



8. Night is closing in so some flash was used down on the
beach. This now looks like a prim and proper Victorian lady

going for a walk on the beach.



-

9. In this version, she has removed her hat and is looking out

into the distance, thinking of a husband at sea...



CHAPTER 9. WAR WEEKEND RE-ENACTMENTS

Explore the world of re-enactments, revivals, nostalgia events and

period-themed festivals

One of the most popular periods in time that people enjoy re-
creating is the 1940s, and specifically, the war years. It's not
because they want to relive the horror of war, but rather enjoy
the fashions and uniforms, the music and the spectacle of re-
enactments. There are various events like this throughout the
year that are all worth your time as a photographer. One of the
best is the War Weekend at Pickering in North Yorkshire, where,
for three days, the town hosts re-enactments, a parade, period-
themed steam train rides and is swamped by people and
dedicated re-enactors in the dress and uniforms of the day. For
the photographer, there’s a variety of disciplines to try out which
includes candid shots, portraits, vehicles and action shots, all of

which require different techniques and approaches.

SHOOTING CANDIDS

With large crowds in period costume you have a great

opportunity for shooting candid photographs. Candids are those

people shots where the subject is unaware that they are being



photographed so they don’t pose or take a rigid expression for
the camera. The idea is to either pick out expressions or details
in figures, or to find individuals and isolate them from the
crowd. Needless to say a long lens is the pre-requisite here as
the further away you are, the more unobtrusive you can be and
the more successful the candid shots. How long is long enough
though? Well, really you're talking about a focal length of
3oomm or more. The good news is that if you have a DSLR
camera with a DX format sensor, rather than the larger FX
format sensor, then there will be a focal length extension,
typically 1.5x the focal length set on the lens. So, that 200mm
lens will give you the range of a 30o0mm focal length and a
3oomm lens will extend it out to the equivalent of 450mm

which is extremely useful.

Not all lenses are created equal though, which is the reason
nature photographers have such expensive kit. It all comes down
to the maximum aperture, or the lowest f-stop, at the end of
the telephoto. The wider the aperture, the more it costs. A
typical consumer superzoom with a range of 28mm-30o0mm is
likely to have a maximum width aperture of around f/6.3 at the
telephoto end. This has two implications: shutter speed and
depth-of-field. Firstly, shutter speed. The longer the lens, the
faster shutter speed you need to keep the photo sharp and
avoid camera shake. Typically, the reasoning goes that you need
the focal length, expressed as a part of a second. So, if you
have a 300mm lens you need 1/300th sec shutter speed to

avoid shake. Now, this can be taken with a pinch of salt since



if you have shaky hands or it's a windy day you need faster
speeds and if the camera is well braced or you have really good

image stabilisation then you can get away with slower speeds.

The point about the maximum aperture is that a very expensive
lens will give you f/2.8 at the 300mm end, thus delivering more
light and giving you a faster shutter speed. That f/6.3 setting
might sound similar but it lets in less than a quarter of the
light that the /2.8 lens does. Set your camera in AP mode and
dial in the widest aperture. If you then find that the shutter
speed is not fast enough you will need to increase the ISO
rating. On a sunny day you might be able to use 1SO100 or
ISO200, on a cloudy day 1SO200, 400 or 800, and if shooting
people who are in the shade then ISO1600 could be required.
So, the advice here is frame your subject and check the shutter

speed to see if it is fast enough.

The other point mentioned was depth-of-field. Now, telephoto
lenses have much less depth-of-field than wide angle lenses, but
even so, an aperture of f/6.3 focussed on a figure standing
towards the end of the telephoto will still result in some detail
being present in the background. Yes, it won’t be in focus, but
you'll still be able to read signs and make out people. So, for
long lens work, the wider the aperture the better all round. The
other issue to consider is if you are about to buy a new lens. A

fixed prime lens will offer better quality than a superzoom and



also a better wide aperture setting, without breaking the bank.
Of course, it isn’t as flexible as a superzoom or one of those

expensive f/2.8 telephoto lenses.



140mm (210mm), f/5.6, 1/640th sec, 1SO1600, -0.7EV, CW

A group of re-enactors talking at the train station, captured with
a modest telephoto. | waited until the woman turned her head

and looked along the platform.



116mm (174mm), f/5.6, 1/250th sec, 1SOs00, -0.3EV, CW

A short telephoto shot of a woman in uniform struggling up the
hill. 1t was overcast so needed a higher ISO rating to keep the

shutter speed up.



)

X

3oomm (450mm), f/6.3, 1/8oth sec, 1SO400, -0.3EV, CW

This shot was risky with a low shutter speed but the camera
was well braced and there was no time to change the settings

before they moved again.



116mm (174mm), f/5.6, 1/100th sec, 1SO400, -0.3EV, Zone

This is part re-enactment, part candid. There was a plastic bag
in the shot that had to be removed in Photoshop



HERE COMES THE PARADE

As well as shooting candids with your long lens it can also be
just as useful when photographing parades. Now, the temptation
is to just get the wide angle lens out and shoot everything
going past. To do this you need to be in good shooting
position, not behind someone, and not shooting sideways into
the parade as this simply gives flat and messy results. To get
the front end of vehicles into a shot, try angling your camera.
This fits the body shape of a vehicle into the square of the shot
and also provides for a more dynamic composition. If there's
room it can be worth trying a panning shot which keeps the
subject relatively sharp but blurs the background. However, you
need plenty of shooting room for this, nothing in the way and
the subject to be moving at a decent speed. Vehicles moving at
walking speed are likely to be going too slow to make this
work. However, if you fancy having a try, set your aperture to
f/22 to slow the shutter speed right down, pre-focus on the area
the subject will go through and then turn autofocus off and wait
for the subject to arrive. As the target enters the start of the
tracking area, compose and shoot and then move the camera
with the subject in the middle through the shot. The faster the
target is moving, the shorter the exposure time needed to blur
the background. Ideally you want to be aiming for anything from

half to 1/8th of a second. A long shutter speed will make it



impossible to get the subject sharp, so if necessary, be prepared
to go dial down to f/8 or f/11 if the exposure time is too long.
Back to the telephoto lens now though. If you are in a crowd
then the best bet is to use this to zoom in through a gap so
you don’t have people at the front of the shot. Focus and look
for details and expressions of people in the parade. Because the
field of view is narrower on a telephoto lens, you can exclude

the surrounding crowd or areas and isolate interesting subjects.



200mm (3oomm), f/6, 1/500th sec, 1SO400, -1EV, Zone

Everyone in this line was looking ahead but when the middle
figure turned to look to the right, | focussed on him and shot.
Bright background light required minus exposure compensation
to retain highlights.



17mm (25smm), /8, 1/40th sec, 1SO100, -0.7EV, Zone, flash

The angled shot gets the front of the jeep in while flash was
used to brighten the foreground and a little panning used with

focussing on the MP driver.



FACE FRONT SOLDIER

At this point it's time to swap the telephoto lens over for your
best portrait lens. Actually, that might be the same thing, but
what we want here is a shallow depth-of-field which makes
something like a somm f/1.4 or /1.8 prime lens ideal. If you
don’t have one then rather than go for the wide angle zoom in
your kit bag, get that telephoto lens out again, use it at the
shorter end so you have as wide an aperture as possible and
stand further back. It is tempting to use the wide angle, short
zoom lens, that is standard for landscapes and groups,
especially if it's something like 17-35mm, so on a DX format
DSLR it gives 25-52mm, but that 52mm end is likely to have
something like an f/4 aperture which really just is nowhere near
as good as the results from the prime lens. Anyway, an aperture
of f/1.4 or f/1.8 really will throw the background completely out
of focus leaving the view to focus on the subject. In terms of
the subjects, because you are now engaging with them, you'll
need to ask permission to take the photo. You can’t just shove
the lens in someone’s face and shoot away. Fortunately most
people at events like this are only too happy to be
photographed, though if it's the end of a long day they may
have had enough so be polite and respect the reply. It's
important that the subject behaves in character though, so you
don’t want grinning guards or people jumping up and down

unless they've just been told the war is over and that’s the



scenario they are portraying.

Normally you wouldn’t want someone squinting into sunlight,
and to a degree you still don’t here. If it's a bright and sunny
day try shooting them backlit using centre-weighted or spot
metering, or get them to stand in the shade. It can work
though, especially if the subject is in uniform, because they can
look grim and serious, and also, subjects in military uniform
may have hats, caps or helmets that will keep the sun out of

their eyes.



/o
somm (75mm), f/1.8, 1/500th sec, 1SO100, -0.7EV, CW

A Luftwaffe pilot in full flying gear. He was stood in the shade

so this was an easy shot.



somm (75mm), f/1.8, 1/2000th sec, 1SO100, -0.7EV, CW

Very bright sunshine so this Russian soldier stood with her back

to it with just a touch of rim lighting on the shoulders and hat.



somm (75mm), f/1.8, 1/320th sec, 1SO100, -0.3EV, CW

This enthusiastic chap was a member of the crowd but happily
posed by someone else’s car and put his best Teutonic glare for

the camera.



N

somm (75mm), f/1.8, 1/8oooth sec, 1ISO100, -0.7EV, CWA

metering

Getting close to the limit of the shutter speed of the camera for

a wide aperture shot in bright daylight.



somm (75mm), f/2.2, 1/200th sec, ISO160, -0.7EV, CW

A snap shot in a dark tent. The reason for the happy smile is
that this woman was playing the part of the French resistance,

welcoming people into a café.



IT'S TIME FOR ACTION

No period event would be complete without some form of re-
enactment. Often you'll find the participants setting up camp
first, whether that's civil war era, knights and horses or WWII
with vehicles and genuine weapons. This is your chance to get
round to talk to people and learn about the period but also get
some more shots. The portrait shots come into play again but
also for vehicles or a large scene you'll need a wide angle lens
to get it all in. In the case of vehicles you want it all to be
sharp, unless focussing on a small detail like an identifying
badge. That means using apertures like f/8 but be aware that
even f/2.8 on a 17mm lens will produce a lot of depth-of-field.
So, if you don’t want anything in the background you really

need to exclude it when composing the photo.

There’s a case to be made for employing some filters when
shooting wide angle scenes or vehicles. For the former, a
graduated neutral density filter will help balance the exposure if
the sky is much brighter than the landscape area. In the latter,
a polariser can help cutting out reflections from glass so that
you can see into vehicles rather than looking at your own

reflection.

When it comes to actual battle scenes then it’s back to the



telephoto lens to zoom in but before the shooting starts you
need to work out where to stand. For a start, if it's sunny and
you're shooting into it, then everything will either come out
severely underexposed or you won’t have any detail in the sky.
So, check where the sun is and position yourself so it's behind
you or at least to the side. The other factor to consider is that
of where the general public are going to be standing. Ideally you
don’'t want the crowd in the background to the shot. Sometimes
though it's a question of the lesser of two evils, and in this

case, go for the better lighting situation.



3oomm (450mm), /6.3, 1/640th sec, 1ISO200, -0.3EV, CW

The main German camp with officers and an engineer. A long
telephoto shot isolated the subjects which were backlit by the
sunshine. | had to wait for the flag to flap in just the right
position.



3oomm (450mm), /6.3, 1/640th sec, 1SO320, -0.3EV, CW

The Russians push the German forces back in the battle scene.
Strong sunlight kept the shutter speed high without having to
increase the 1SO too much.



GIVE IT SOME AGE

The thing about digital camera images is that they all look so
fresh and clean. For period looks it really shouldn’t be that
sharp or uniform so it's a good idea to distress, add grain, fade
corners and mess up the colours in either Photoshop, Paint
Shop Pro or Elements. Ordinarily you'd try to keep away from
using high 1SO ratings but with modern DSLRs the noise tends
to be uniform rather than multi-coloured, so it'’s more like the
grain from high ISO film. Compact cameras have a different
approach and aggressively reduce noise, usually making the
image very soft. Add grain with the software editing program
and either mute the colours or tone them with a sepia overlay.
Two Photoshop-compatible plug-ins that can be highly
recommended are Alien Skin Software’s Exposure 5 and Nik
Software’s Color Efex Pro 4.



CHAPTER 10. FUTURE SHOCK

Take fashion into a post-apocalyptic future with a location-based

shoot in the ruins of an abandoned society.

The idea behind this fashion-gone wrong location shoot was to
place it in a post-apocalyptic settings, where there are people
who still have money, but look down their noses at the rest of
humanity scrabbling around the rubble. And then there are those
in the ruins, who have disconnected with society and live in
their own dream worlds. The location needed plenty of
abandoned buildings and ruins, lots of rubble and fences.
Building sites, where old houses are knocked down, but the site
hasn't been cleared yet, are ideal for this kind of thing. Slightly
safer are abandoned industrial units and complexes. There are a
couple of things to bear in mind when finding your ideal
location and they all revolve around security and safety. Firstly,
just because the place is a ruin, doesn’t mean that no-one owns
it. If it has been recently demolished then it's likely that the
area has been bought, will have security guards or at least
fences. Shooting on such ground is basically trespass and while
you can usually talk your way out of any difficulties, it being
obvious that you are a photographer, there with a model, the
least you could expect if encountering security, is to be escorted
off the site.



There are physical dangers too. The more destroyed the site is,
the more unsafe it becomes. Don't expect to get your subject to
walk around over crumbling floors, it's a risk they should not be
taking. Also, climbing over rubble is far from easy if the subject
is wearing heels and a sprained ankle, a fall and cut hands are
all very possible. It's down to you to make sure that the area
you shoot on is both safe and practical for whatever the model
is wearing. The final point about security is this: try to have an
extra pair of hands along with you. This goes for any location-
based shoot. Someone to watch the bags, use a phone or
provide extra numbers is invaluable. Also, don’t shoot this at
night. Grim places like abandoned warehouses and buildings are
magnets for criminal activity, and you turning up with a pile of
expensive camera gear makes you a target for theft, at the very
least. And there are much worse things that can happen. So,
night time shoots in locations like this really should be avoided

unless you have a large team of people.

PREPARATION WORK

The plan was, that this would be shot on a dreary day, lots of
cloud overhead, so it looked depressing. Cloudy skies are ideal
for portraits as there is no sun that will cause harsh shadows

and squinting, or flare if you shoot towards it. You can use



bounce flash from a flashgun if you need directional light and
the diffuse light is great on faces. So after scouting the location
in such conditions, when we turned up to do it, the sun came
out and it was glaringly bright all afternoon. Those are the
knocks from location shooting though. Unless you have a large
budget and willing models, it's difficult to re-arrange them. The
other point is that at least you can still shoot in the sunshine,
though it’s harder, if it rains there are even worse problems.
Check the forecast on the day and ensure you have a current
mobile phone number for everyone taking part. Scouting a
location first always pays dividends. You know where the best
shots are, where you can go, and in this case, if it's raining,
whether there are decent undercover locations or if you need to

cancel the entire thing.

As far as models go, you can almost always get someone for a
location shoot on a TFP or TFCD basis (prints or CD) because
anything that offers variety and imagination is good for a
model’s portfolio. If you want more choice, then post a casting
call on somewhere like www.purestorm.com in the UK or
www.net-model.com in the USA or overseas and offer a £15-£20
($25-$35) an hour fee. On the free basis, if you want to draw in
models from further afield than the location of the shoot, then
offer travelling expenses up to £30/$50. Those with cars or low-
cost railcards will then be willing to travel in. Ensure you have a
car if they are coming by train or are on foot, so you can pick

them up.



The other point about preparation is to ensure that you know
what type of shot you are going for so you can instruct the
model on posing and attitude, and make sure you have
discussed clothing and accessories before hand. Most models,
except the very new, have astoundingly large wardrobes. They
also tend to know other models and can borrow specific items.
Get it all worked out for yourself first, then discuss what you
need with the model when you've found one that best suits
your type of shoot. A quick tip here: When advertising a shoot
online, don't accept the first offer that comes along. Also, if you
are inexperienced at directing models and have never done a
location-shoot before, try to get a model who isn't a beginner.
Most models will have some idea of what to do, even if you
don't. As long as you brief them fully at the start, you don't

have to macro-manage every single pose.

If you have someone for a two-hour shoot, try to get them to
arrive fully clothed and made up — unless it's something
outrageous and they are travelling on public transport. That way
you save valuable time and can get straight into the shoot. They
should have another two complete changes of clothes so that
after the first set, you can move around the location, get them
changed and have time for another two sets. Getting changed
and altering the hairstyle takes up time but if the model arrives
ready to go, and If you're quick, you can even get four complete

sets done in two hours.



It's worth noting that at all times you should be respectful of
the model’s personal space and privacy. On a location like this,
your car may be parked some way back from the site, so it
isn't practical to return to it to get changed. That being the
case, the model will need to get changed in situ. Simply find
more discrete areas and keep your eye out for passers-by, don’t
stand and gawp. When clambering over any rough ground, hold
your arm or hand out for the model to hold on to, carry all the
gear, and refrain from grabbing and holding to shove through

some small gap in a wall.



SHOOTING IT

While it's entirely down to you what you bring, here are some
options. A wide-aperture portrait lens — somm or 7smm with
f/1.4 or f/1.8 will enable you get some great shallow depth-of-
field shots with diffuse backgrounds. If it's really sunny, that
means that dialling in f/1.8 in Aperture Priority mode and
hoping that your camera shutter speed is fast enough to cope.
You should also be on the lowest ISO rating you can get. If it’s
very bright, the shutter speed may still not be fast enough, in
which case, having a neutral density filter in your kit bag will
pay dividends. Slot this in front of the lens and reduce the light
coming in by two or four full aperture stops. The converse of
this applies if shooting inside a ruin — it's going to be dark.
While the wide open aperture is essential here, it may be too
dark for a hand held shot. Anything slow that 1/30th sec is
going to give you problems. In this case either considering
using some flash — and the most effect way to do it is with a
flashgun that has a movable head. Point at a wall or ceiling and
bounce the light back onto the subject. Or, increase the ISO
rating until you get a fast enough shutter speed when using AP
model.

The other lens suggestion is a telephoto one — 200mm



upwards. This has three advantages. The first is that you can
place the model a long way away in the ruins, and shoot from
distance where it would be impossible with a wide angle lens.
The second is that telephoto lenses have less depth-of-field than
wide angle lenses at the same aperture settings so it's easier to
get the background out of focus. The third is that a telephoto
lens narrows the field-of-view, so you can exclude things to the
side of the model. All of which brings us around to the wide
angle lens — 35mm and under, that you may be tempted to use
because you are stood close to the model and it's the only way
of getting her and the background in shot. Refer to the first
chapter on Back to Basics to see what happens as regards to
lens distortion. It usually isn’t nice. The best way to use it, is
to exaggerate the effect for dramatic purposes. Otherwise,

compose the image better and use the other lens types.



somm lens (75smm effective), AP mode, /2.8, 1/5000th sec,
ISO100, -0.3EV, CWA metering

So here’s the first of our decadent shots, with a clearly



overdressed model doing her best snooty pose. An aperture of
f/2.8 was used so that all of the model was in focus, but the

background wasn't.



21mm lens (33mm effective), AP mode, f/5.6, 1/20th sec,
ISO100, 0.7EV, CWA metering

This is a wide angle shot, but from a low-ish angle to use the



small amount of distortion to enhance the length of the legs.

The shutter speed was just fast enough.
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21mm lens (31mm effective), AP mode, f/5.6, 1/15th sec, 1SO100,
-0.7EV, CWA metering

Using the wide angle lens again to go for a punk-rock type



look, with the distortion purposefully on the head and arms for
this pose. The significant exposure compensation reading was to

ensure highlights didn’t blow out because it was very bright.



200mm lens (30omm effective), AP mode, f/5.6, 1/200th sec,
ISO100, spot metering

Using the telephoto lens with the future-lost concept to remove



the side detail and render the background diffuse. Not that f/5.6
on this lens blurs the background whereas f/5.6 on the wide

angle lens doesn’t. Also, because the subject was backlit, spot
metering on the dress was used.



98mm lens (147mm effective), AP mode, f/5.3, 1/320th sec,
ISO250, spot metering

Here with the telephoto lens to shoot the subject stood a good



ten feet higher than the camera, in the ruined shell of a

building. The ISO was increased to keep the shutter speed up.



Practical Digital Portraits and all the images contained within it
are copyright 2014 Duncan Evans. Please report any pirate

copies of this e-book to dg@duncanevans.co.uk

If you liked this e-book you may be interested to know that

there are two others in the range currently.

An Intensive Introduction to Digital Photography is a crash

course in the basics of digital camera operation.

Get Started in Digital Glamour Photography (Lingerie Edition) is
a guide for both film and digital users wanting to try the world
of glamour photography.

Both books can be ordered from where you bought this ebook.

Simply search for Duncan Evans to find them.

There is also another version of Get Started in Digital Glamour
Photography — the nudes edition, at the same price.
Unfortunately nude photography is not allowed through the
Smashwords channel but if you would rather buy that version

you can do so through PayPal. Send me an email at



dg@duncanevans.co.uk for details of how to pay and receive it.

All orders are fulfilled the same day via email.
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